
1 ➢ NCSA Telnet for the Macintosh®

Configuration

NCSA Telnet for the Macintosh® allows you to customize the environment to suit special needs and 
habits. This chapter describes the configuration system used by NCSA Telnet for sessions, the use of 
saved sets, and the several global preferences.

Configuration of the file transfer related services is described in Chapter 4, "File Transfer."

Configuration Overview

NCSA Telnet has several preference options that effect every session or the operation of NCSA Telnet 
in general. Those preferences are described in the section "Global Preferences."

NCSA Telnet 2.6 utilizes an entirely new configuration system. Previously, NCSA Telnet required an 
external text file named config.tel. That file contained several keywords that specified the user’s 
preferences. The configuration system for NCSA Telnet 2.6 is entirely graphical in nature and does not 
require any external user-editable files.

Connection Preferences System Rationale and Overview
NCSA Telnet’s configuration system for connections is comprised of two parts, "Sessions" and 
"Terminals". Ideally, all of the configuration options for a connection would be combined into one 
entity. However, due to the great number of options for each connection, the options have been divided
into the aforementioned categories. The "terminal" configuration record contains the options that 
pertain primarily to the terminal emulation done by NCSA Telnet. The "session" configuration record 
contains the remaining options. Each session configuration record has a terminal configuration record 
associated with it. The terminal record associated with a given session record is entirely up to the user.

The <Default> Session and Terminal Configuration Records
The <Default> terminal and session configuration records are set to reasonable defaults when NCSA 
Telnet is launched for the first time. The user may change the preferences in the <Default> records, but
the <Default> records may not be deleted.

The <Default> session and terminal records are used when the user enters a hostname in the open 
connection dialog box. The preferences contained in the <Default> records are used as the defaults for 
any connection that does not have a preconfigured session or terminal record. The <Default> records 
are also used to set the initial values of any new terminal or session configuration records the user may 
define.

Global Preferences

To edit the Global Preferences, select Global from the Preferences submenu of the Edit menu. A modal 

dialog box will appear:
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2 ➢ NCSA Telnet for the Macintosh®
Each of these options are described in the following sections.

Command Keys
When Command Keys is checked, the menus are configured to accept command key equivalents.

Note: When NCSA Telnet is running on a Macintosh that has no control key, NCSA Telnet will remap 
the  key to the  control key if Command Keys is not checked. If Command Keys is checked on such 
machines, the user will have no way to generate control key characters.

Remap Backquote to ESCape
When Remap backquote to ESCape is checked, NCSA Telnet sends the ESCape character to the remote 
host when the ` key is pressed. This is useful for users with the original Macintosh or Macintosh Plus 
keyboards. This option, however, is available to users regardless of their keyboard type. Pressing -` 
will always produce a backquote character, regardless of the setting of this option.

Copy Table Threshold
The Copy Table Threshold value determines the number of spaces which, at a minimum, are replaced 
by tabs when the user issues the Copy Table command from the Edit menu or press -T. Instead of 
using the standard Copy command, the user can use the Copy Table command to copy tables of data 
from the NCSA Telnet screen onto the Clipboard.

When the user uses the Copy Table command, all strings of contiguous spaces that are greater than the 
threshold are turned into tabs before being placed on the Clipboard. This produces a format that can be 
pasted into most spreadsheet and graphing programs without losing data or requiring additional 
formatting.

Timeslice
The Timeslice value determines how much time NCSA Telnet gives to other applications that may be 
running. Increasing this value reduces NCSA Telnet’s responsiveness, but improves the performance of
the applications in the background. The value is measured in sixtieths of a second.

Windows Don’t Go Away
When Windows Don’t Go Away is checked, session windows remain open after their associated 
connections have terminated. The window title is placed within parenthesis to signify that the 
associated connection has closed. To close such a window, click in the window’s close box, or select 
Close from the File menu.

This feature allows the user to view, copy, and print text that is in a window whose connection has 
been closed. It is also useful for reading connection error messages that occur with hosts which may 
close connections immediately after they are established due to an error.

Staggered Windows
When the user selects the Staggered Windows option, the program staggers multiple windows by a 
whole title bar, allowing the user to see each window’s title. Otherwise, NCSA Telnet only staggers 
each new window by a few pixels.

Blink Cursor
If Blink Cursor is checked, NCSA Telnet periodically blinks the cursor present in session windows.

Cursor Selection
Clicking the appropriate radio button: block, underscore, or vertical bar selects the type of cursor used 
by NCSA Telnet for the cursor present in session windows.

Capture File Creator
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3 ➢ NCSA Telnet for the Macintosh®
Every file on the Macintosh has a filetype and file creator type. The filetype specifies the type of file 
(e.g. text file, word processing document, saved set). The file creator type tells the Finder which 
application to launch when a user double-clicks on a file. NCSA Telnet lets the user specify the creator 
type given to the files in which NCSA Telnet saves captured text from sessions. If the user knows the 
four letter creator type for the application the user wishes to specify, type it in the Capture File Creator 
field. If the user does not know the four letter creator type, click the Select Application button. NCSA 
Telnet will present the user with a standard open file dialog box. Double click on the application the 
user wishes to find the creator type for. NCSA Telnet will then enter the four letter creator type in the 
Capture File Creator field for the user.

Editing Session or Terminal Configuration Records

When the user selects Terminals or Sessions from the Preferences sub-menu of the Edit menu, a modal 

dialog box similar to this one will appear:

To add a new session or terminal, click on New. To change an existing terminal or session record click 
on Change. To remove an existing terminal or session record click on Remove. The <Default> records 
can not be removed.

Session Configuration Records

When the user creates a new session configuration record or change an existing record, the 
following modal dialog box is used:
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4 ➢ NCSA Telnet for the Macintosh®

These fields and options are described in the following sections:

Alias
The Alias field specifies the name of the session configuration record. Typing the text contained in this 
box in the Host/Session Name field of the Open Connection dialog will make NCSA Telnet use the 
configuration information contained in this session configuration record, as well as the information 
contained in the terminal configuration record specified by the Terminal popup menu in the session 
configuration record dialog box. NOTE: Spaces are not allowed in alias names.

When editing the <Default> session configuration record, the Alias field is disabled, as the <Default> 
records cannot be renamed.

Hostname
The Hostname field contains the text passed to MacTCP’s Domain Name Resolver (DNR). The 
Domain Name Resolver translates a host’s domain name into an IP address.

Port
The Port field specifies the port on which NCSA Telnet will attempt to connect to the remote machine.

TEK Options
There are three choices for Tektronix emulation in NCSA Telnet. Inhibit prevents NCSA Telnet from 
using any Tektronix emulation for this session. 4014 and 4105 select Tektronix 4014 emulation or 
Tektronix 4105 emulation, respectively.

Paste Method
NCSA Telnet can use two different methods when pasting data into a session. If Quick is selected, 
NCSA Telnet sends all of the data to be pasted to the remote host at once. This method works well for 
small amounts of text and for sessions involving hosts that are close to the user on the network. For 
pasting large amounts of text, or when the user is connected to a machine that is slow to respond, the 
Block paste method is recommended. When the Block method is selected, NCSA Telnet sends the data 
to be pasted to the remote host in sections, or blocks of text. The size of the blocks is determined by the
number entered in the field next to the Block radio button.
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5 ➢ NCSA Telnet for the Macintosh®
The Delete Key

Some hosts expect the delete character for deleting, others expect the backspace character. Selecting 
Delete or Backspace determines what character NCSA Telnet will send to the remote host when the user
presses the DELETE character on the user’s keyboard.

Forcesave
Forcesave forces NCSA Telnet to always save the contents of the screen to the scrollback buffer. This 
option is only for users of full screen VMS environments such as DEC All-In-One.

Berkeley 4.3 CR Mode
This is a special compatibility option for 4.3 BSD UNIX. There is an official UNIX bug fix for this 
problem, but some hosts may still want CR-NULL to be used as the end-of-line character.

Allow linemode
When Allow linemode is checked, NCSA Telnet will negotiate and use linemode with hosts that support 
it. If this option is not checked, NCSA Telnet will refuse to use linemode.

TEK Page clears screen
When this option is on, NCSA Telnet’s Tektronix emulation will clear the current Tektronix window 
when a Tektronix clear screen command is received. If this option is off, NCSA Telnet will create a 
new window for the new Tektronix image. Each new screen created in this way has as its name the 
session name and time. For more information regarding Tektronix drawing mode and the clear screen 
code, refer to Chapter 5, "Tektronix 4014 and 4105 Emulation."

Half Duplex
This option only applies to hosts that negotiate non-echoing mode but do not expect local line editing. 
If checked, all character keys are sent and echoed to the screen immediately, otherwise the characters 
are echoed locally and queued until a RETURN or CONTROL character is sent. This parameter has no
effect when local echo is off.

Show low level errors
Turning this option on tells NCSA Telnet to display minor error conditions it normally would not. This 
can be useful when the user is trying to diagnose a problem with NCSA Telnet.

Interrupt, Suspend, and Resume
NCSA Telnet uses certain key combinations for the telnet functions Interrupt, Suspend, and Resume. 
The default key assignments for the Interrupt, Suspend, and Resume functions correspond to the 
traditional interpretation of ASCII characters.

The Interrupt, Suspend, and Resume telnet functions and their default key assignments are discussed 
below.

Interrupt (CONTROL-C) Function

The Interrupt function sends a telnet interrupt process character that is equivalent to the Interrupt 
Process command in the Network menu (see "Network-Related Commands" section in Chapter 3, 
"Advanced Features"). The host implementation of telnet is required to listen for and interrupt the 
current application when this option is received.

Interrupt also does a timing mark operation. In many implementations of telnet, the user presses 
CONTROL-C and can wait several minutes before the text stops scrolling on the user’s screen. This 
occurs because the TCP protocol has buffered up to 16K or even 32K bytes of data, which is waiting in
the pipeline to be delivered even before the user presses CONTROL-C. To avoid this, NCSA Telnet 
initiates a process known as timing mark flush when the user issues an interrupt command.
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6 ➢ NCSA Telnet for the Macintosh®
To do timing mark processing, NCSA Telnet sends to the host a special character, which the host 
echoes back. While waiting for the host to echo, all characters for that session are thrown away. The 
session appears to pause for up to 15 seconds and then resumes as usual. During the pause NCSA 
Telnet is throwing away all of the buffered data so that the user does not have to wait for it to be 
displayed.

Suspend (CONTROL-S) Function

The Suspend function instantly interrupts all output coming from the network. The current session does
not produce any more characters on the screen until the user issues the Resume command.

Resume (CONTROL-Q) Function

The Resume function allows character printing to resume to the current session. Resume does nothing 
unless a Suspend command is in effect.

Terminal Popup Menu
The Terminal popup menu selects which terminal configuration record will be used when the alias 
identifying this session configuration record is used to open a session.

Translation Table Popup Menu
The Translation Table popup menu selects which translation table will be initially selected for this 
session.

Terminal Configuration Records

When the user creates a new session record or change an existing record, the following modal dialog 

box is used:

These fields and options are described in the following sections.

Terminal Name
This is the name of the terminal that will appear among the other terminal configuration records in the 
Terminal popup menu of the session configuration record dialog. When editing the <Default> terminal 
record, this field is hidden.

Xterm sequences
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7 ➢ NCSA Telnet for the Macintosh®
When Xterm sequences is checked, NCSA Telnet will recognize the Xterm escape sequences for 
changing window and icon titles. NCSA Telnet will change the title of the session’s window in 
response to those sequences.

Use VT wrap mode
When this option is on, NCSA Telnet will set the VT emulator to use auto-wrap mode by default.

The VT terminal maintains an internal setting to determine whether characters printed off the right 
hand side of the screen cause the terminal to wrap or not. If the user sets the terminal to wrap, the new 
characters appear on the next line of the screen and the screen is scrolled if necessary. If the user 
disables wrap mode, each new character replaces the last character on the current line and the cursor 
neither moves right nor onto the next line. Whenever the user selects the Reset Terminal command in 
the Session menu, wrap mode is disabled.

EMACS arrow keys
When this option is on, the arrow keys will send the appropriate control codes for moving around in 
the EMACS editor. When this option is off, NCSA Telnet sends the VT codes for the arrow keys. This 
option also affects the codes sent when the option mouseclick feature is used. See the section "Cursor 
Positioning with the Mouse" in Chapter 3, "Advanced Features" for more information.

Mapping the PageUp, PageDown, Home, and End Keys
When Map PgUp, etc. is checked, NCSA Telnet will use the PAGE UP, PAGE DOWN, HOME, and 
END keys to move the position in the session’s scrollback buffer, rather than sending the VT codes for 
these keys to the remote host.

Eight bit connections
When this option is on, NCSA Telnet does not strip the eighth bit from the data it receives.

Save cleared lines
When this option is on, NCSA Telnet saves the screen in the scrollback buffer before clearing the 
screen when a VT clear screen code is received. Otherwise, the data on the screen is lost.

CNTL-COMMAND is EMACS meta
When this option is on, pressing CONTROL, COMMAND, and a key is equivalent to pressing Meta 
and that key on a keyboard that has a Meta key. This option does not allow the sending of Meta 
Control keys since the CONTROL key is needed to activate this sequence. This option will be changed
in the future to better support simulating Meta key sequences.

Emulation
The VT100 and VT220 radio buttons select VT100 or VT220 emulation for this connection, 
respectively.

Font and Size
The Font popup menu and the size field to the right of the Font popup menu allow the user to specify 
the font and font size to be used for this connection.

Screen Size
The Screen Height and Screen Width fields allow the user to specify the initial size of the VT emulation 
screen.

Scrollback
The Scrollback field determines the size, in lines, of the scrollback buffer.
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Screen Colors

The four fields used for setting the foreground and background colors for normal and blinking mode 
are only visible on color equipped Macintosh computers. When they are present, clicking on any of the
boxes will present the standard Color Wheel modal dialog box. The boxes are filled with the current 
color selection. For additional information on using the Color Wheel modal dialog box, refer to the 
Macintosh System Software User's Guide.

Changing Configuration After the Session Has Been Created

After a session has connected, many of the configuration parameters can be changed by using the 

Session menu.

Each of the items is described in the following sections.

Backspace and Delete
When Backspace is checked, the DELETE key sends a backspace character when pressed. If Delete is 
checked, the DELETE key sends a delete character when pressed.

Local Echo
When linemode is not being used, NCSA Telnet can operate in two different echo modes: local and 
remote. In local echo mode, characters are copied to the screen immediately as the user types them. In 
remote echo mode, the characters are sent to the host, which sends them back to be printed. When 
Local Echo is checked, NCSA Telnet enters local echo mode.

Wrap Mode
Enables or disables the wrap mode of the VT terminal emulator. Refer to "Use VT Wrap mode" in the 
section "Terminal Configuration Records" for further explanation.

EMACS arrow mapping
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9 ➢ NCSA Telnet for the Macintosh®
When EMACS arrow mapping is checked, the arrow keys send codes appropriate for moving around in 
the EMACS editor. When EMACS arrow mapping is not checked, NCSA Telnet sends the VT codes for
the arrow keys.

Map PgUp, PgDown, Home, End
When Map PgUp/PgDown/Home/End is checked, NCSA Telnet will use the PAGE UP, PAGE DOWN, 
HOME, and END keys to move the position in the session’s scrollback buffer, rather than sending the 
VT codes for these keys to the remote host.

Translation Submenu

The Translation submenu allows the user to choose which translation table will be used for this session.
In the case above, no translation is desired.

Clear Screen Saves Lines
This option toggles between saving lines and erasing lines when the VT clear screen code is received. 
If the user checks the option, all lines currently displayed on the screen are scrolled into the scrollback 
region before the screen is cleared. If this option is not checked, the cleared lines are permanently 
disposed of when the screen is cleared.

Reset Terminal
Select Reset Terminal to reset the VT screen, for example when a host program accidentally sets VT 
graphics mode or fails to leave VT graphics mode. The Reset Terminal command resets all VT mode 
settings, disabling wrap mode, resetting VT graphics mode, resetting the keypad mode to the default, 
and resetting tabs to every eight spaces.

Jump Scroll
Select Jump Scroll to skip to the end of the local buffer.

The Jump Scroll option causes the screen to pause and then jump ahead over scrolling text. The text is 
placed into the scrollback, but the screen update advances to the end of the local network buffer instead
of printing every line on the screen.

The purpose of this feature is to save time. For example, when the user enters a command that 
produces a great deal of output, the user can use Jump Scroll to avoid waiting for the output to scroll 
by.

TEK Page
Select TEK Page to quickly create or clear a Tektronix emulation window without requiring 
intervention from host software.

Normally the emulation window appears automatically when the clear screen command sequence is 
received from the host. But the TEK Page command creates the window immediately. To clear the 
current session window, use the TEK Page command the same way the user would use the Page key on 
a real Tektronix terminal. For more information regarding the clear screen command and Tektronix 
emulation, refer to Chapter 3, "Advanced Features."

The TEK Page option is disabled if the user has selected Inhibit as the TEK Emulation in the session 
configuration record used to create this session. Refer to "TEK Options" in the section "Session 
Configuration Records" for more information.

TEK form feed clears screen
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10 ➢ NCSA Telnet for the Macintosh®
Setting this option forces NCSA Telnet’s TEK emulation not to clear the screen when a form feed is 
encountered. Often TEK images include a form-feed command at the end of them which cause the 
TEK screen to be immediately cleared upon reaching the end of the image. However, this makes it 
hard to see the final image of the TEK file. 

Set Screen Size
Select this option to change the size of the VT emulation screen.

NCSA Telnet’s VT emulation screens contain 24 lines by default, because an actual VT terminal screen
has room for exactly 24 lines of text. Some host systems allows the user to define a VT-like terminal 
type which has more or fewer than 24 lines. NOTE: The user may change this default by changing the 
terminal configuration record. Refer to "Screen Size" in the section "Terminal Configuration Records" 
for more information.

To increase or decrease the size of the VT emulation screen:

Select Set Screen Size from the Session menu. A modal dialog box appears, showing the current 
number of lines and columns in the VT emulation screen.

Change the value as desired.

Click OK or press RETURN to return to the user’s session window or click Cancel to abort the 
change.

If the user changes the size of the VT emulation screen, the session window will resize to reveal the 
entire VT screen.

Shortcut

To quickly change the size of the VT emulation screen, hold down OPTION before adjusting the size 
of the window using the size box. As the window changes size, NCSA Telnet recalculates the number 
of lines in the window and displays the current dimensions in the upper left corner of the window. 
When the user releases the mouse button, the size of the VT emulation screen will be set. This method 
is equivalent to using the Set Screen Size command. NOTE: Resizing a session window without 
holding down OPTION only resizes the Macintosh window and does not change the size of the VT 
emulation screen.

WARNING: If the user does not have a good working knowledge of how the user’s host system makes
us of terminals with greater than 24 lines, you are recommended to use only 24-line windows. The 
following warnings and suggestions assume knowledge of UNIX-based software to control the number
of lines for the terminal. Consult your host system documentation or system administrator for more 
information.

Warnings and Suggestions

The termcap file, (found in UNIX systems only), is commonly located in /etc/termcap, and can be set 
up to include the number of lines on the terminal. The default VT100 termcap includes an explicit 
setting of 24 lines, so even if you enlarge your NCSA Telnet window, the host uses only the top 24 
lines. You can create special termcap entries by editing the /etc/termcap file. Copy the VT100 entry to 
a new name and change the number of lines to your preferred screen size.
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Berkeley UNIX-based systems have a special feature in the stty program. The number of rows in a 
session window can be set to any value, and applications programs such as vi learn your window size 
from the stty setting. The following command line sets the window size to 33 lines.

stty rows 33

Using the special macro variable #, you can create a macro that issues this command and automatically
substitutes the number of lines for the current window. For example, you could define the macro for 

-0 as the following.

stty rows \#

Now, you can set the window size by pressing -0 and then RETURN. The sequence \# is replaced 
with the proper number of lines.

See the section "Defining Macros" in this chapter for information about creating and saving macros.

Some systems have a program installed called resize. Resize sends a special sequence of VT control 
characters to NCSA Telnet’s VT emulator to determine the size of the screen. If resize is available on 
your system, putting

resize > /dev/null

in your .cshrc or .login will automatically set your screen size correctly when you log in. For help 
using resize and determining if it is available at your site, contact your system administrator.

NAWS

NAWS, Negotiations About Window Size, is a relatively new option in the telnet standard. UNIX hosts
that support NAWS allow NCSA Telnet to send information to the host regarding the VT window size. 
Consequently, when the user changes the VT screen size by using the Set Screen Size option, the new 
screen size is sent over the network to the host. In this case, the user does not need to perform the stty 
rows operation. The host knows how big the window is, which eliminates possible problems for 
screen-oriented applications such as vi. NOTE: NAWS is not supported by all UNIX machines. You 
can determine if the host you are connected to supports NAWS by changing the size of the VT 
emulation screen and then asking the remote host for the screen size. If the screen size the host 
responds with matches the new screen size you have just set, the host supports NAWS.

Setup Keys
Select Setup Keys to select which keys, if any, issue the telnet commands Interrupt, Suspend, and 
Resume (see "Interrupt, Suspend, and Resume" in the section "Session Configuration Records" in this 
chapter.)

Font Submenu
The Font submenu contains the fonts that you may use to display text in a session window. When you 
select a font from this submenu, the current window is resized to contain the text and the selected font 
is used to display all text in the current window.

NOTE: Fonts which are proportionally spaced (most fonts except Courier and Monaco) display slowly
and appear spread out.

Size Submenu
This option allows you to change the size of text in the current window. The Size submenu contains the
point sizes that you may use to display text in a session window. The submenu lists several sizes, 
displays a check-mark next to the current size, and outlines all sizes present in your system. When you 
select a size from this submenu, the current window is resized to contain all the resized text and the 
text is redrawn according to the specified point size.

NOTE: Sizes which do not appear outlined in the submenu must be scaled by the system software and 
therefore may be slow and not as sharply defined as the non-scaled sizes.
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Color

The Color option only applies to Macintosh computers that are color-equipped. Select Color to change 
the foreground and background colors of the current window for both normal text and blinking text. 

The Color Selection modal dialog box appears.

To assign a color to text or the background of a session window:

Click the box next to the item to which you wish to assign a color: Normal Text, Normal 
Background, Blinking Text, or Blinking Background. This will bring up the Color Wheel modal 
dialog box.

Select a new color by clicking in the color wheel. The color you select appears in the top rectangle 
under the heading Please Select New Color.

Click OK or press RETURN to enable the color change and return to the Color Selection modal 
dialog box. The box next to the item you selected in Step 1 reflects the color you chose from the 
Color Wheel modal dialog box.

Repeat Steps 1 through 4 to assign colors to other items in the Color Selection dialog box.

Click OK when you have finished choosing colors. The colors you selected are applied to your 
current session window.

For additional information on using the color wheel dialog box, refer to your Macintosh System 
Software User's Guide.

Capture Session to file
NCSA Telnet is able to save the text from a session to a file. When Capture Session to file is selected, all
normal text output that appears on the screen will also be saved to the file specified by the user in the 
standard save file dialog presented. This functionality turns on when the user selects this menu item, 
and turns off when the user again selects the menu item. As is standard with NCSA Telnet, a check will
appear in the menu when this option is selected, to inform the user that the text from that session is 
being captured.

Saved Sets

NCSA Telnet makes it easy for you to begin multiple telnet sessions quickly. This allows you to log on 
and get right to work without resetting the special characteristics and configuration of a connection 
each time you start up. This is accomplished through saved sets.

A set is a snapshot of the open sessions and their current configuration. A set consists of current macro 
settings and each session's window location and size, connected host, window name, scrollback setting,
color, font, font size, backspace/delete settings, and all other configuration information.

Saving a Set
To save a set:
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Log on to the desired host as instructed in Chapter 1, "Getting Started."

Customize the session by moving the session window to an ideal location on the screen, specifying a 
background or text color, choosing a font and font size, setting the desired number of scrollback 
lines, and choosing the function for the BACKSPACE/DELETE key.

Select Save Set from the File menu. 

A standard file dialog box appears and prompts you to name the set. After naming the set, click on the 
Save button in the dialog box to save the set.

Using a Saved Set
Using sets lets you bypass the start-up procedure described in Chapter 1, "Getting Started." 
Specifically, you do not need to select Open Connection from the File menu or press - -O to open a 
connection, nor do you need to specify the connection host or window name. These operations are 
performed automatically when you load a set.

After you load a set, the session window automatically appears for the specified host at the specified 
location on the screen and with the specified window name, scrollback setting, color and other 
characteristics. The following characteristics are saved in a set:

session name
hostname
port number
window size and location
scrollback setting
BACKSPACE/DELETE key setting
macro definitions
command key setting
number of columns
Tek clear screen setting
font and font size
color characteristics
assigned keys for Interrupt, Suspend, and Resume functions
CRMAP setting
"Allow linemode" setting
eightbit status
translation table setting
TEK emulation setting
answerback message

Loading a set from the Finder

To load a set from the Finder and automatically invoke NCSA Telnet, doubleclick on the set icon or 

file. The sample below shows the set icon for a set named Setup One. 

Loading a set from within NCSA Telnet

To load a set from within the NCSA Telnet application, select Load Set from the File menu. In the 
standard file dialog box that appears, select and open the set.

NOTE: You can edit a set datafile using any editor capable of editing files, even if the files are not of 
the operating system type TEXT. However, NCSA recommends that you do not rely on this feature, as 
it may not work with future versions of NCSA Telnet.
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Defining Macros

NCSA Telnet lets you use the key combinations -0 through -9 as macro keys. You can program  
these keys to send from 0 to 255 characters.

To define a macro:

Select Set Macros from the Edit menu or press -M. The Macro Configuration modal dialog box 
below shows several sample macro definitions.

Click on the button of the command key you wish to define, or select the box next to that button.

Enter the appropriate macro key sequence as instructed in the following section.

Click on the OK button in the dialog box (or press the RETURN key) to activate the new macros, or 
click on the Cancel button to invalidate the additions or changes you made. Clicking either the OK 
or Cancel button returns to the application.

Reverting to the Previous Macro Definitions
While you are working in the Macro Configuration dialog box, you can undo changes you made to a 
macro and revert the associated command key to its previous setting by clicking on the button 
corresponding to that command key. For example, to undo changes to the definition for -2, click on 
the button labeled 2 . To simultaneously abandon all changes you have made, click on the Cancel 
button.

Entering Macro Key Sequences
The key sequences used to generate special control characters in a macro may seem somewhat strange,
unless you are familiar with the C programming language. To define a special character, you must first 
enter a backslash (\). Indicate nontypable control characters with their equivalents in the octal 
numbering system. Below are some common macro key combinations you might want to enter:

Desired Character                    Definition
Backslash (\)                        \\
TAB                                  \t
ESC       \033
CONTROL-C       \003
CONTROL-D       \004
CONTROL-E       \005
CONTROL-H or BACKSPACE               \010
Size of current window†       \#
Internet address of this Macintosh†† \i

†   Concerns setting the number of usable lines in a session window. See the 
   "Using the Session Menu" section of this chapter.
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††  See also the discussions of the Show Network Numbers command in the "Network-
   Related Commands" section of Chapter 3, "Advanced Features," and of the 
   Send IP Number command in the "Transferring Files" section of Chapter 4, 
   "File Transfer."

Saving Macros
Currently, the only way to save the macro settings is in a set file. See the section "Saved Sets" in this 
chapter for more information regarding sets. NCSA plans to extend the macro capability of NCSA 
Telnet in future versions.
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